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1. Scope 

This document is the User’s Manual (UM) for the Enhanced Logistics Intratheater Support Tool 
(ELIST) Software Segment.  It tells how to use the end-user and administrative features of the 
segment.  The instructions in Sections  4.2.1, 5.3.1, and 5.3.2 for the end-user features (Run 
ELIST and Run ETEdit) only cover the launching of those features in the DII COE 
environment; full details on the operation of ELIST and ETEdit in any environment can be found 
in the documents listed in Section 2.1.3 and referenced elsewhere in this document.  On the other 
hand, complete instructions for the administrative features (Add Map Data and Delete Map 
Data) are presented in Sections 4.2.2, 5.3.3, and 5.3.4 of this document. 

1.1 Identification 

The ELIST Software Segment is one of seven segments that make up the DII COE ELIST 
mission application. 

Table 1 identifies all the segments of the ELIST mission application.  In the table, each segment 
is given a number by which it may be referenced in this document.  The table also gives the 
name, the segment type (and, if a data segment, the segment scope), the current version number, 
and the directory name assigned to each segment. 

Table 1.  Segments of the ELIST Mission Application 

Segment 
Number 

Segment 
Name 

Segment 
Type / Scope 

Version 
Number 

Directory 
Name 

1 ELIST Global Data Segment Data / Global 8.1.0.0 ELISTglob 
2 ELIST Database Instance Segment Data / Segment 8.1.0.0 ELISTdbinst 
3 ELIST Database Fill Segment Data / Local 8.1.0.0 ELISTdbfill 
4 ELIST Database Segment Database 8.1.0.0 ELISTdb 
5 ELIST Database Utility Segment Software 8.1.0.0 ELISTdbutil 
6 ELIST Software Segment Software 8.1.0.0 ELISTexec 
7 ELIST Reference Data Segment Data / Local 8.1.0.0 ELISTrefdata 

All seven segments have the following identification properties in common: 
 
Segment Prefix1:  ELIST 

 
Platform(s)2:   Sun/Solaris 7 
 
DII COE Versions:  4.2.0.0P4 or later 

All seven of the ELIST segments must be installed before you can use the ELIST mission 
application.3 

                                                 
1 Note carefully that all segments have the same prefix.  This is not typical of multisegment DII COE 
mission applications. 
2 Implementation of the ELIST segments for PC/Windows NT 4.0 will follow shortly.  This 
documentation covers only the Sun/Solaris 7 platform but will be supplemented or replaced when an 
implementation becomes available for NT. 
3To save space, however, the ELIST Database Fill Segment can be removed after successfully installing 
the ELIST Database Segment. 

 26 February 2002 1 



 ELISTexec.8100.Final.SOL7.UM 

Refer to the Introduction to the Enhanced Logistics Intratheater Support Tool (ELIST) Mission 
Application and its Segments: Global Data Segment, Database Instance Segment, Database Fill 
Segment, Database Segment, Database Utility Segment, Software Segment, and Reference Data 
Segment for the following: 

• an overview of the mission application and all of its segments in the context of the 
application; 

• the definitions of key concepts and terms used throughout the ELIST 
documentation; 

• a complete list of the available ELIST documentation. 

• a brief history of ELIST; and 

• basic information pertinent to the client/server configuration and installation of 
the ELIST segments. 
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2. Referenced Documents 

The following other documents are referenced in this document. 

2.1 Government Documents 

2.1.1 DII COE ELIST Documents 

Introduction to the Enhanced Logistics Intratheater Support Tool (ELIST) Mission Application 
and its Segments: Global Data Segment Version 8.1.0.0, Database Instance Segment Version 
8.1.0.0, Database Fill Segment Version 8.1.0.0, Database Segment Version 8.1.0.0, Database 
Utility Segment Version 8.1.0.0, Software Segment Version 8.1.0.0, and Reference Data Segment 
Version 8.1.0.0 for Solaris 7, ELIST.8100.Final.SOL7.Intro, Argonne National Laboratory, 
26 February 2002 

Software Version Description (SVD) for the Enhanced Logistics Intratheater Support Tool 
(ELIST) Software Segment Version 8.1.0.0 for Solaris 7, ELISTexec.8100.Final.SOL7.SVD, 
Argonne National Laboratory, 26 February 2002 

Installation Procedures (IP) for the Enhanced Logistics Intratheater Support Tool (ELIST) 
Global Data Segment Version 8.1.0.0, Database Instance Segment Version 8.1.0.0, Database 
Fill Segment Version 8.1.0.0, Database Segment Version 8.1.0.0, Database Utility Segment 
Version 8.1.0.0, Software Segment Version 8.1.0.0, and Reference Data Segment Version 8.1.0.0 
for Solaris 7, ELIST.8100.Final.SOL7.IP, Argonne National Laboratory, 26 February 2002 

System Administrator’s Manual (SAM) for the Enhanced Logistics Intratheater Support Tool 
(ELIST) Database Segment Version 8.1.0.0 for Solaris 7, ELISTdb.8100.Final.SOL7.SAM, 
Argonne National Laboratory, 26 February 2002 

2.1.2 Other DII COE Documents 

N/A. 

2.1.3 Other ELIST Documents 

ELIST v.8.1: User’s Manual, ANL/DIS/TM-62, Argonne National Laboratory, February 2002 

ETEdit v.1.0: User’s Manual, ANL/DIS/TM-63, Argonne National Laboratory, February 2002 

2.1.4 Other Government Documents 

Classified Matter Protection and Control Manual, DOE M 471.2-1B, U.S. Department of 
Energy 

2.2 Non-Government Documents 

N/A. 
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3. Software Summary 

3.1 Software Description 

ELIST was developed to help military planners use resources efficiently in different types of 
operations under various conditions.  The system makes it possible to simulate a scenario that 
involves movement of equipment via land, sea, or air or by a combination of the three types of 
transport. 

ELIST answers questions such as the following: 

• Will the theater infrastructure support the plan? 

• Are the theater assets sufficient to support the given delivery dates (that is, are 
there enough railcars, aircraft, etc., to deliver the assets on time? 

• Where are the bottlenecks in the theater transportation system? 

• What are the effects of exogenous events on the transportation infrastructure?  For 
example, if all of the bridges are impassable, how will the flow of assets be 
affected and how can the military react? 

The executable features of the ELIST Software Segment are launched in the standard way (i.e., 
double-clicking desktop icons).  They naturally fall into two distinct groups, which are covered 
in the next two subsections. 

3.1.1 End-User Features 

The segment provides end-user features, called Run ELIST and Run ETEdit, for performing 
ELIST simulations and editing ETPFDDs, respectively.  These features are accessible by general 
ELIST users (i.e., users in the elistusr group, to whom the Security Administrator has 
assigned the General ELIST User profile). 

The capabilities represented by these end-user features are as follows: 

• Dynamic map interface 

• Create, edit, import, and export commodity and rule sets 

• Edit, expand, and create EPTFDD data 

• Networks 

• Scenarios 

• Simulations 

• View planned movements and reports (to be added in a future release) 
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Operating improvements include the following: 

• Simulation to the vehicle level 

• Cross-platform environment 

• Oracle RDBMS 

The benefits of using the end-user features of ELIST are as follows: 

• Planners can predict the feasibility of transporting sufficient supplies to a 
specified location in a given amount of time. 

• Based on delivery time, ELIST automatically finds the shortest route; a future 
release will allow users to define routes. 

See Section 3.4.1 for further information on the end-user features of the ELIST Software 
Segment. 

3.1.2 Administrative Features 

The segment also provides administrative features, called Add Map Data and Delete Map 
Data, for managing the NIMA map reference data stored in the ELIST Reference Data Segment.  
These features are only accessible by administrative ELIST users (i.e., users in the elistadm 
group, to whom the Security Administrator has assigned the Administrative ELIST User 
profile). 

These features logically belong in the ELIST Reference Data Segment, which, in DII COE 
terminology, is classed as a data segment.  However, data segments cannot have icons or, 
consequently, executable features  (launched in the required way).  Thus, these features have 
been relegated to the ELIST Software Segment. 

Some map data are required for every ELIST simulation; the required data depend, of course, on 
the locale of the simulated operations.  Thus, an administrative ELIST user is required to 
perform an essential function before a new general ELIST user can run simulations. 

NIMA map reference data can consume hundreds of megabytes.  Therefore, careful management 
of the resources available to the ELIST Reference Data Segment is a significant issue.  To make 
space available for new reference data, it may be necessary to delete reference data that are no 
longer needed to support ongoing operations.  It is for this reason that the authority to delete 
such data is thus invested in a group of users having administrative responsibilities.  
Administrative ELIST users can also be general ELIST users. 

See Section 3.4.2 for further information on the administrative features of the ELIST Software 
Segment. 

3.2 Software Inventory 

The ELIST Software Segment is only one segment of the ELIST mission application; all seven 
segments must be installed to use the ELIST software.  Installation of these segments creates all 
the necessary databases and directory structures to support the operation of the ELIST mission 
application. 
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As mentioned in the previous section, however, an administrative ELIST user must add NIMA 
map reference data necessary to support simulations in a given theater location to the ELIST 
Reference Data Segment before general ELIST users can perform simulations for that theater. 

The icons for adding and deleting map reference data are only visible to administrative ELIST 
users, and only they can launch the features associated with those icons.  This safeguard is 
intended to ensure that a general ELIST user does not inadvertently delete map reference data 
still in use by other users.  Administrative ELIST users are assumed to be cognizant of the 
operations being conducted by the general ELIST users at their site. 

The icons for performing simulations and editing ETPFDDs are visible to general ELIST users. 

The icons of the ELIST mission application are visible only to those users to whom the General 
ELIST User profile or the Administrative ELIST User profile has been assigned by the 
Security Administrator.  Furthermore, in a Sun Solaris 7 operating system environment, only 
those users whom the Security Administrator has placed in the elistusr or elistadm 
operating system groups have access to the segments of the ELIST mission application, and to 
their files and directories.  Unauthorized users cannot use ELIST and cannot even discover 
which theaters are the subject of ongoing operations. 

No special software is required to continue or resume operation in case of an emergency. 

3.3 Software Environment 

For information on the hardware and software environment that must be in place to install and 
use this segment, see the Installation Procedures (IP) for the Enhanced Logistics Intratheater 
Support Tool (ELIST) Global Data Segment, Database Instance Segment, Database Fill 
Segment, Database Segment, Software Segment, and Reference Data Segment. 

3.4 Software Organization and Operation Overview 

3.4.1 End-User Features 

ELIST is an important tool for military planners.  By using the Run ETEdit feature of the 
ELIST Software Segment, general ELIST users can specify the amount of equipment to be 
moved, the type of transport to be used, and the time of departure and arrival of equipment at a 
designated location (i.e., can modifiy ETPFDDs).  By using the Run ELIST feature of the 
segment, these planners can edit asset sets, networks, and scenarios and can simulate the 
movement of supplies and evaluate the feasiblity of their plans.  

Several menu options are available through ELIST, and a separate menu is provided for each 
major category.4  Because only one area can be edited at a time, ELIST has built-in system 
checks that support data integrity. 

Loading a network or scenario may take a few minutes.  Performing a simulation, however, 
requires significant CPU time.  Accuracy and reliability of simulations are discussed in the 
ELIST v.8.1: User’s Manual (see Section 2.1.3). 

 
4 ETEdit is available not only through the Run ETEdit feature but also through a menu item of the Run 
ELIST feature. 
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The reports and unit viewer speed are directly linked to the speed of the computer and the size of 
the ETPFDD; generally, however, reports should load in less than thirty seconds.  If a power 
failure occurs while data are being saved, it might be necessary to re-enter some changes; 
however, all of the data will not be lost. 

To launch one of the end-user features, see Section 4.2.1. 

3.4.2 Administrative Features 

The ELIST Reference Data Segment provides a framework (directory structure) for storing 
NIMA reference map data that is to be used for performing one or more ELIST simulations.  As 
distributed, that segment contains a starter set of WVS data, some part of which is needed for 
every simulation.  At present, the distributed data includes the available WVS maps at 
resolutions of 1:12,000,000, 1:40,000,000, and 1:120,000,000.5  The segment, as distributed, 
does not include any NIMA raster product map data, such as ADRG, CADRG, or DTED data, 
primarily because each CD of such data contains 300 MB to 600 MB of data.  There are 
hundreds of such CDs.  Typical sites will be able to store only a few CDs online at any one time, 
and the locations of interest to military planners cannot be anticipated.  Therefore, it is up to an 
administrative ELIST user at an operational site to determine what NIMA raster product map 
data CDs to obtain and load into the ELIST Reference Data Segment to support simulations in 
the locales of interest to the general ELIST users at the site.  Administrative ELIST users add 
such data to the segment using the Add Map Data feature, and delete map data that are no 
longer needed using the Delete Map Data feature. 

To launch one of the administrative features, see Section 4.2.2. 

3.5 Modes of Operation 

ELIST does not incorporate different modes of operation. 

3.6 Security and Privacy 

ELIST is an unclassified software system; that is, an individual does not require a security 
clearance to look at or access any part of the ELIST software.  Nevertheless, ELIST can be used 
to perform classified simulations.  When used for classified purposes, it is expected that ELIST 
will be installed on a secure system (one that meets the applicable security requirements for 
classified uses) and that all the users who have access to the system possess the necessary 
security clearance. 

WARNING:  “Access to classified matter shall be limited to persons who possess appropriate 
access authorization and who require such access (need-to-know) in the performance of official 
duties” (from Classified Matter Protection and Control Manual, DOE M 471.2-1B, U.S. 
Department of Energy).  When using ELIST for classified purposes, users must follow the 
proper procedures for working in a classified facility.  Safeguards include, for example, not 
revealing passwords to anyone and not making copies of the software or printed documents. 

                                                 
5 The available WVS maps at resolutions of 1:250,000, 1:1,000,000, and 1:3,000,000 are not included, 
but because these smaller scales may be important in some studies, a future enhancement of the Add Map 
Data feature of the ELIST Software Segment is being considered, which will allow these data sets to be 
added to the ELIST Reference Data Segment, from the NIMA WVS CD, after the segment’s installation. 
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Notwithstanding the above, standard access controls are in place to restrict access to the 
segments of the ELIST mission application, and their directories and files, to users who have 
been given the necessary operating system accounts by the Security Administrator, including 
membership in the necessary operating system groups and assignment of the necessary profiles.  
See Section 3.2.  Users also must have been given ELIST database user accounts by an 
administrative ELIST user.  Each user is, of course, required to supply his or her own operating 
system password when logging in to the machine; furthermore, the Run ELIST and Run 
ETEdit features prompt the user for his or her database account password. 

Restrictions on the releasibility of this segment are outlined in the Software Version Description 
(SVD) for the Enhanced Logistics Intratheater Support Tool (ELIST) Software Segment. 

WARNING:  The making of unauthorized copies of this software or associated documentation 
is prohibited by DISA. 

3.7 Assistance and Problem Reporting 

To obtain assistance with the use of this segment (specific to the DII COE environment), or to 
report problems, follow the instructions in Section 8. 

 26 February 2002 9 
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4. Access to the Software 

4.1 Software Setup 

4.1.1 Installation and Configuration 

For information on installing the ELIST mission application, consult the Installation Procedures 
(IP) for the Enhanced Logistics Intratheater Support Tool (ELIST) Global Data Segment, 
Database Instance Segment, Database Fill Segment, Database Segment, Software Segment, and 
Reference Data Segment.  Installation of DII COE segments can only be performed by the 
System Administrator (sysadmin user). 

4.1.2 Familiarization 

Instructions for adjusting equipment, the characteristics of the display screens, keyboard layout, 
and other information will be included in a future version of this document. 

4.1.3 Access Control 

To obtain an operating system account, contact your site’s Security Administrator (secman 
user).  Tell the administrator whether you need to be enrolled as a general ELIST user or an 
administrative ELIST user.  The administrator will enroll you, place you in the appropriate 
operating system group (elistusr for general ELIST users; both elistusr and elistadm 
for administrative ELIST users), and assign the appropriate profile (General ELIST User or 
Administrative ELIST User) to you.  The administrator will choose your initial operating 
system password and provide it to you.  The first time you log in to the machine, you will be 
required to change your operating system password. 

When you are granted access, an administrative ELIST user (perhaps the same person as the 
Security Administrator) will also give you an ELIST database user account and will provide your 
database password to you.  At present, you cannot change that password yourself, but an 
administrative ELIST user can change it for you, if required.  A future release of the system will 
allow you to change it yourself. 

4.1.4 Customizing ELIST 

The first time you use the Run ELIST or Run ETEdit feature, an ELISTexec subdirectory is 
created under your data/Prefs directory, and a text file called wvsColors.txt is copied 
into it.  This file contains a default color map for the countries displayed on the initial ELIST 
world map (see Figure 5).  These colors can be altered from within ELIST by selecting View → 
Map Properties and then clicking the Colors tab; they can also be changed by editing the file 
with a text editor outside of ELIST. 

In addition, an ELIST8_data subdirectory is created under your data directory the first time 
you use the Run ELIST or Run ETEdit feature, and five data files are copied into it.  (These 
files support the processing initiated by selecting the Network → Import (Land File) and 
View → View TACWAR Units menu items.)  By default, scenarios, networks, ETPFDDs, and 
rule sets are stored in the ELIST8_data subdirectory (as .dmp files) when you export them 
from ELIST, and it is in that directory that ELIST searches for such files when you import them 
into ELIST. 

 26 February 2002 11 
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4.2 Initiating a Session 

4.2.1 End-User Features 

To start ELIST to run a simulation, or to start ETEdit to create or edit ETPFDD data or 
commodity or rule sets, perform the following steps: 

Step 1. On the application client platform on which the ELIST Software Segment is 
installed, log in as a general ELIST user (i.e., a user in the elistusr group 
to whom the Security Administrator has assigned the General ELIST User 
profile). 

Step 2. Press the right mouse button on the desktop to open the Workspace Menu.  
While continuing to press the right mouse button, select Workspace Menu → 
Applications → Application Manager to open the Application Manager 
Window. 

Step 3. In the Application Manager Window, double-click the DII_APPS folder to 
open the Application Manager - DII_APPS Window. 

Step 4. If the ELISTexec folder is not displayed in the Application Manager - 
DII_APPS Window, the current profile is not the right one.  Switch to the 

proper profile by clicking the Profile Selector icon  in the CDE panel; 
double-click General ELIST User under Available Profiles in the Profile 
Selector Window, then click Ok, and finally click Done.  When the proper 
profile is selected, the ELISTexec folder is displayed in the Application 
Manager - DII_APPS Window. 

Step 5. Double-click the ELISTexec folder.  The Application Manager - ELISTexec 
Window opens, displaying the two icons for the end-user features of the 
ELIST Software Segment as shown in Figure 1. 

 
Figure 1.  Icons for the End-User Features 

of the ELIST Software Segment 

Step 6. Double-click the icon for the desired end-user feature (Run ELIST or Run 
ETEdit). 

A terminal window opens, in which progress messages and error diagnostics 
are written by the selected feature.  This window is read-only from the user’s 
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perspective.  It remains open until it is explicitly closed at the end of the 
session, giving the user a chance to study and/or record any unexpected error 
diagnostics (see Section 4.3).  There is no other purpose for the terminal 
window. 

A moment later, a Password Entry Window similar to that shown in Figure 2 
opens.  (In this example, the user was logged in as “dritz.”) 

 
Figure 2.  Password Entry Window for Your ELIST Database Account 

Step 7. In the Password Entry Window, enter the ELIST database user account 
password that was assigned to you by an administrative ELIST user (see 
Section 4.1.3), then click OK. 

NOTE:  If you launched the Run ELIST feature in Step 6, continue with 
Step 8 in Section 5.3.1; if you launched the Run ETEdit feature in Step 6, 
continue with Step 8 in Section 5.3.2. 

4.2.2 Administrative Features 

To add NIMA map reference data to the ELIST Reference Data Segment from a NIMA map CD, 
or to delete such data from that segment if no longer needed, perform the following steps: 

Step 1. On the application client platform on which the ELIST Software Segment was 
installed, log in as an administrative ELIST user (i.e., a user in the 
elistadm group to whom the Security Administrator has assigned the 
Administrative ELIST User profile). 

Step 2. Press the right mouse button on the desktop to display the Workspace Menu.  
While continuing to press the right mouse button, select Workspace Menu → 
Applications → Application Manager to open the Application Manager 
Window. 

Step 3. In the Application Manager Window, double-click the DII_APPS folder to 
open the Application Manager - DII_APPS Window. 

Step 4. If the ELISTexec folder is not displayed in the Application Manager - 
DII_APPS Window, the current profile is not the right one.  Switch to the 

proper profile by clicking the Profile Selector icon  in the CDE panel; 
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double-click Administrative ELIST User under Available Profiles in the 
Profile Selector Window, then click Ok, and finally click Done.  When the 
proper profile is selected, the ELISTexec folder is displayed in the 
Application Manager - DII_APPS Window. 

Step 5. Double-click the ELISTexec folder.  The Application Manager - ELISTexec 
Window opens, displaying the two icons for the administrative features of the 
ELIST Software Segment as shown in Figure 3. 

 
Figure 3.  Icons for the Administrative Features 

of the ELIST Software Segment 

Step 6. Either double-click the Add Map Data icon and continue with Step 7 in 
Section 5.3.3, or double-click the Delete Map Data icon and continue with 
Step 7 in Section 5.3.4. 

4.3 Stopping and Suspending Work 

To terminate ELIST or ETEdit normally, select Exit from the File menu and confirm your 
intention to exit by clicking Yes in the Question Window that opens (or resume working by 
clicking No); then close the terminal window that opened in Step 6 of Section 4.2.1 by clicking 
OK in the Message Window that opens next.  (Click OK only after recording any error 
diagnostics of interest appearing in the terminal window.) 

Perhaps as an accident of the implementation, rather than by design, ELIST and ETEdit can also 
be terminated by typing Ctrl-C in the ELIST or ETEdit window, or in the terminal window.  
Since this method is an abnormal termination that may not perform clean-up actions, it is not 
recommended unless there is no other way of terminating ELIST or ETEdit. 

Once started, the Add Map Data and Delete Map Data administrative features should be left to 
terminate by themselves at the end of their processing.  Note that they are both rather lengthy 
processes. 
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5. ELIST Software Segment Processing Guide 

5.1 Capabilities 

See Sections 3.4.1 and 3.4.2 for a brief overview of the capabilities of the individual features. 

5.2 Conventions 

Access to all the features is by means of desktop icons.  Sections 4.2.1 and 4.2.2 explain how to 
launch a particular feature. 

All transactions are carried out through a graphical user interface.  Information that is required 
for a feature to perform its processing is requested from the user in an appropriate prompt 
window, and the user enters the requested information into that window. 

Colors and alerts are not used to convey information. 

5.3 Processing Procedures 

The following subsections give instructions for the use of each feature from the point at which it 
has been started according to the instructions in Sections 4.2.1 or 4.2.2. 

5.3.1 Running ELIST 

Use the following instructions to continue after you have completed Step 7 in Section 4.2.1. 

Step 8. After a brief delay, the ELIST Window opens, initially displaying the ELIST 
logo as shown in Figure 4. 
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Figure 4.  ELIST Logo Displayed in the ELIST Window 

Step 9. As ELIST continues to load various items from the database (a process that 
takes about one minute), the cursor is displayed as an hourglass, and ELIST is 
not receptive to mouse clicks.  At the conclusion of the loading process, the 
ELIST Window displays a world map, as shown in Figure 5. 
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Figure 5.  World Map Displayed in the ELIST Window 

ELIST is now ready to process user commands, which are entered by 
selecting from its menus. 

For complete instructions on the detailed processing capability of ELIST, 
consult the ELIST v.8.1: User’s Manual (see Section 2.1.3). 

To exit from ELIST, see the instructions in Section 4.3. 

5.3.2 Running ETEdit 

Use the following instructions to continue after you have completed Step 7 in Section 4.2.1. 

Step 8. After a brief delay, the ETEdit Window opens, initially displaying the ETEdit 
logo as shown in Figure 6. 
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Figure 6.  ETEdit Logo Displayed in the ETEdit Window 

ETEdit is now ready to process user commands, which are entered by 
selecting from its menus. 

For complete instructions on the detailed processing capability of ETEdit, 
consult the ETEdit v.1.0: User’s Manual (see Section 2.1.3). 

To exit from ETEdit, see the instructions in Section 4.3. 

5.3.3 Adding Map Data 

Use the following instructions to continue after you have completed Step 6 in Section 4.2.2. 

Step 7. A Question Window similar to the one shown in Figure 7 opens. 

 
Figure 7.  Question Window for Proceeding after Inserting a Map CD 
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Insert a NIMA map reference data CD into the CD-ROM drive, wait (about 
ten seconds) for the File Manager Window showing the CD to open, and then 
click Proceed.  (Or, to stop adding map data, click Cancel instead, and 
dismiss the informational message that appears.) 

NOTE:  The processing procedures are the same regardless of the type of the 
NIMA data—ADRG, CADRG, or DTED. 

Step 8. If the data on the CD have not already been loaded into the ELIST Reference 
Data Segment, and if there is enough space on the drive on which that 
segment is installed, loading of the data begins; otherwise, an error message is 
displayed in a Message Window, and processing terminates when the window 
is closed. 

It may take an hour or more to copy the data.  When the data have been 
completely copied, a Message Window similar to the one shown in Figure 8 
opens.  (In this example, the arc4_gncxx11_______1 data have been 
loaded.) 

 
Figure 8.  Message Window Indicating Successful Addition of Map Data 

Click OK. 

5.3.4 Deleting Map Data 

Use the follwoing instructions to continue after you have completed Step 6 in Section 4.2.2. 

Step 7. A Text Entry Window similar to the one shown in Figure 9 opens.  (In this 
example, the only map data set found online is named 
arc4_gncxx11_______1.  If no NIMA map data sets are online, a 
different message is displayed.) 
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Figure 9.  Text Entry Window for Selecting the Map Data to Delete 

Enter the name of one of the data sets in the list and click OK.  (Or, to stop 
deleting map data, click OK without entering a name and then dismiss the 
informational message that appears.) 

Step 8. The selected map data are deleted, a process which can vary in duration from 
seconds to half an hour or more.  At its conclusion, a Message Window 
similar to the one shown in Figure 10 opens.  (In this example, the 
arc4_gncxx11_______1 data have been deleted.) 

 
Figure 10.  Message Window Indicating Successful Deletion of Map Data 

Click OK. 

5.4 Related Processing 

N/A. 

5.5 Data Backup 

N/A. 

5.6 Error Recovery 

See the next section. 
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5.7 Messages 

If a requested feature cannot be launched, or if a failure is detected during its performance, the 
nature of the problem is conveyed in a Message Window.  The messages are intended to be self-
explanatory.  (In the case of ELIST and ETEdit, messages may be written only to the terminal 
window that opened in Step 6 of Section 4.2.1.)  Problems that are not understood should be 
communicated to the developer (see Section 3.7) or via the DII COE Hotline (see Section 7). 

One failure that can be reported in a message warrants special attention here.  If Oracle writes a 
message to the terminal window to report that the ELIST_DATA, ELIST_INDEX, 
ETPFDD_DATA, or ETPFDD_INDEX tablespace has filled up, then a DBA will have to take 
steps to recover and allow operation to continue.  The appropriate recovery steps are documented 
in the System Administrator’s Manual (SAM) for the Enhanced Logistics Intratheater Support 
Tool (ELIST) Database Segment. 
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6. Notes 

The following acronyms are (or may be) used in this document. 
 
Acronym   Definition 
 
ADRG    ARC Digitized Raster Graphics 
CADRG   Compressed ARC Digitized Raster Graphics 
CD    Compact Disk 
CDE    Common Desktop Environment 
CD-ROM   Compact Disk Read-Only Memory 
CM    Configuration Management 
COE    Common Operating Environment 
CPU    Cenetral Processor Unit 
DB    Database 
DBA    Database Administrator 
DII    Defense Information Infrastructure 
DII_APPS   DII Applications (desktop folder name) 
DISA    Defense Information Systems Agency 
DTED    Digital Terrain Elevation Data 
ELIST    Enhanced Logistics Intratheater Support Tool (DII COE segment 

prefix) 
ETEdit    ETPFDD Editor 
ETPFDD   Enhanced Time-Phased Force Deployment Data 
GB    Gigabyte(s) 
IP    Installation Procedures 
KB    Kilobyte(s) 
LAN    Local Area Network 
MB    Megabyte(s) 
N/A    Not Applicable 
NFS    Network File System 
NIMA    National Imagery and Mapping Agency 
NT    New Technology (an operating system for Microsoft Windows) 
PC    Personal Computer 
RDBMS   Relational Database Management System 
SAM    System Administrator’s Manual 
SVD    Software Version Description 
UM    User’s Manual 
WVS    World Vector Shoreline 
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8. Documentation Improvement and Feedback 

Comments and other feedback on this document should be directed to: 

Phone: (630) 252-7217 
Fax: (630) 252-5128 
Email: dritz@anl.gov 
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